REN ESAS Application Note

RZ/G2L RZ/G2LC RZ/G2UL RZ/G3S RZ/G3E
Getting Started with Flexible Software Package

Introduction

This material describes how to use the Renesas Flexible Software Package (FSP) for writing applications for
the RZ microprocessor series.

Target Device
RZ/G2L, RZ/G2LC, RZ/G2UL, RZ/G3S, RZ/G3E
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1. Introduction

1.1 Overview
This application note describes how to use the Renesas Flexible Software Package (FSP) running on the

Cortex®-M33 (hereinafter referred to as CM33) incorporated on RZ/G2L, RZ/G2LC, RZ/G2UL, RZ/G3S and
RZ/G3E.

1.2 Introduction to FSP

1.2.1 Purpose

The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy
to use, scalable, high quality software for embedded system design. The primary goal is to provide
lightweight, efficient drivers that meet common use cases in embedded systems.

1.2.2 e? studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ series of
MPU devices. The e? studio IDE provides a familiar development cockpit from which the key steps of project
creation, module selection and configuration, code development, code generation, and debugging are all
managed.

1.3 Limitations

1.3.1 Peripherals and pins assignment

RZ/G2L, RZ/G2LC, RZ/G2UL, RZ/G3S and RZ/G3E have a multi-core configuration of Cortex®-A55
(hereinafter referred to as CA55) and CM33. It is possible to use each peripheral and GPIO from each core.
This package provides drivers for the peripheral for CM33, but each driver can operate on the assumption
that it is not used in CA55.

1.3.2 RAM Initialization

Initialization of DDR SDRAM is always carried out in CA55 bootstrap regardless of the selection of boot
CPU, meanwhile Internal SRAM is initialized in the bootstrap of boot CPU.
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2. Starting Development Introduction

2.1 e?studio setup

21.1 What is e? studio?
Renesas e? studio is a development tool encompassing code development, build, and debug. e? studio is
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing the software for RZ MPUs, e? studio hosts the Renesas Flexible Software Package (FSP).
FSP provides a wide range of time saving tools to simplify the selection, configuration, and management of
modules and threads, to easily implement complex applications.

2.1.2 e?studio Prerequisites
2.1.2.1 Obtaining an RZ MPU Kit

To develop applications with RZ/G FSP, start with each Evaluation Board Kit.
Start-up guide of each Evaluation Board Kit is available at the below page.

e RZ/G2L
RZ/G2L Evaluation Board Kit Quick Start Guide

e RZ/G2LC and RZ/G2UL
SMARC EVK of RZ/G2L, RZ/G2LC, RZ/G2UL Linux Start-up Guide

e RZ/G3S
RZ/G3S Evaluation Board Kit Quick Start Guide
e RZ/G3E

www.renesas.com/rzg3e-evk

2.1.2.2 PC Requirements

The following are the minimum PC requirements to use e? studio:
e Windows 10 or Ubuntu 20.04 LTS Desktop(64-bit) with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e  Minimum 250-GB hard disk

2.1.2.3 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

2.1.3 e?studio installation for Windows PC
This chapter describes how to install the e? studio IDE on Windows PC.

2.1.3.1 Download

The latest e? studio IDE installer package can be downloaded from Renesas website for free. Please check
detailed information from: https://www.renesas.com/e? studio. Note that user has to login to the Renesas
account (in MyRenesas page) for the software download.

RO1AN5924EJ0310 Rev.3.10 Page 5 of 72
July.22.25 RENESAS


https://www.renesas.com/en/document/qsg/rzg2l-evaluation-board-kit-quick-start-guide?r=1467981
https://www.renesas.com/ja/document/gde/smarc-evk-rzg2l-rzg2lc-rzg2ul-linux-start-guide-rev105?r=1467991
https://www.renesas.com/en/document/qsg/rzg3s-evaluation-board-kit-quick-start-guide?r=482476
https://www.renesas.com/e2studio

RZ/G2L RZ/G2LC RZ/G2UL RZ/G3S RZ/G3E
Getting Started with Flexible Software Package

2.1.3.2 Installation of e? studio IDE

1. Double-click on e? studio installer to invoke the e? studio installation wizard page. First, you need to select
Install Type. In this material, it is expected that Custom Install will be selected. Then, click [Next > ]

button to continue.

Note: If e? studio was installed in your PC, the option to modify, remove the existing version or install

e? studio to a different location will be displayed

Standard Install
S 1 '

A Renesas €’ studio Setup O X
Renesas e” studio Setup
LENESAS
Install Type
Please select the e* studio installation type. Click here for help selecting a type and to see what features are included.
Select Install Type:
__ Lite Install (Recommended)
Lite Mode
d experience focused on simple code editing & debugging with only important features

Cancel

Figure 1: Installation of e? studio — Install Type

2. Welcome page

User can change the install folder by clicking [Change...] button. Click [Next >] button to continue.

Note1: If you would like to have multiple versions of e? studio, please specify the new folder here.
Note2: Multi-byte characters cannot be used for e? studio installation folder name.

M Renesas e? studio Setup
Renesas e’ studio Setup
) Welcome Install directory ready

Install Location:

° Prerequisite software already installed

Internet connection available

Change Proxy Settings.

Ready to install
Software to install:
« Renesas e2 studio

+ Java Runtime

« IAR Plugin Manage!

+ Renesas e2 studio Common Components (Lite)

« Renesas e2 studio Common Components (Full)

+ Renesas QE Common Components

+ Eclipse CDT Linker Script Editor and DSL

« Just) Adoptium Open)DK Hotspot JRE Complete

o X
RLENESAS
Cancel

Back

Figure 2: Installation of e? studio — Welcome page
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3. Device Families

Select Devices Families to install. Click [Next >] button to continue.

EA Renesas 2 studio

Renesas e’ studio

Setup ]

o RLENESAS

Select the device families you wish to install support for

Welcome

@ Device Families

O A% RA
Build, Debug & Code Generation support for Renesas RA devices
; RZ
RE : i
Build, Debug & Code Generation support for Renesas RZ devices
0 AW RL78
RU78 Build, Debug & Code Generation support for Renesas RL78 devices
O S
X Build, Debug & Code Generation support for Renesas RX devices
0 AW RH850
RH850 Build, Debug & Code Generation for Renesas RH850 devices
0 AW RE
ReE Build & Debug support for Renesas RE devices
(ReNE Synergy

Build, Debug & Code Generation support for Renesas Synergy devices

— adAdialn~ DA
Select All

< Back Instal Cancel

X

4. Extra Features

Figure 3: Installation of e? studio — Device Families

Select Extra Features (e.g., Language packs, SVN & Git support...) to be installed. For non-English
language users, please select Language packs at this step if needed. Then, click [Next >] button to

continue.

EA Renesas e? studio

Renesas e studio

Setup m}

— RLRENESAS

Select the extra features you wish to install

Welcome

Device Families

@ Extra Features

Japanese Language Support

| =
Chinese (Simplified) Language Support
| -
Chinese (Traditional) Language Support
| -
< Git Integration
| = :
Git SCM Support
Terminals
D - - .
ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet
Select All

i _ <Back I Next > Il Instal Cancel

X

Figure 4: Installation of e? studio — Extra Features
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5. Customize Features

Select the components to install and click [Next >] button to continue. Be sure that Renesas FSP Smart
Configurator Core and Renesas FSP Smart Configurator ARM are selected.

A Renesas e? studio

Renesas e’ studio

Welcome
Device Families
Extra Features

Customise
Features

Setup (u] X

S RENESAS

Select the components you want to install.

([ Renesas Synergy Family Support (24.10.0.R20241003-1714)

(O Renesas DA Family Support (24.10.0.R20241003-1714)

Renesas FSP Smart Configurator Core (10.0.0.v20240930-1428)

Renesas FSP Smart Configurator ARM (10.0.0.v20240924-1500)

([ Renesas RISC-V MCU Support (24.10.0.R20241003-1714)
Renesas QF Common Components (24.10.0.R20241003-1714)
(D Git integration for Eclipse (6.10.0.202406032230-1)

([ Additional Tools (24.10.0.R20241003-1714)

= M ThA Tarminal L 7AAM

Select All Optional | Deselect All Optional

Size of install: 938.1 MB

Figure 5: Installation of e? studio — Customize Features

6. Additional Software

Select additional software (i.e., compilers, utilities, QE...) to be installed. Be sure to select the following
item and click [Next >] button to continue.

e GNU ARM Embedded 13.3-Rel1

Renesas e’ studio

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

EA Renesas e studio

Setup a X

Fe RENESAS

Select the additional software you wish to install

[[] Renesas QE
[[] Renesas Al
~ [ Renesas Toolchains & Utilities
[] Renesas E2 Self-Checking Program V1.02.00 v1.0200 10008
[[] Renesas E2 Lite Self-Checking Program V1.00.00 v1.00.00 1000 B
[] Renesas E1, E20 Self-Checking Program V1.01.00 v1.01.00 1000 B

w [8] GCC Toolchains && Utilities
GNU ARM Embedded 13.3-Rel1 13.3.1.arm-13-24 197.8 MBI

[v] GNU ARM Embedded 12.2-Rel1 122.1.arm-12-24 1000 B

[ GNU ARM Embedded 6 2017q2 6.0.0.2017q2 1000 B

GCC ARM A-Profile (AArch64 bare-metal) 13.2Rell 132.1.20231009 10008

[] GCC ARM A-Profile (AArch64 bare-metal) 10.3 2021.07 103.0.2021-07 10008

[ LibGen for GNU ARM Embedded 1.2024.04 10008

[ LibGen for GNU AARCH64 Embedded 1.2024.04 1000 B
[] Renesas RA FSP

381.5 MB download required

< Back Next > Cancel

Figure 6: Installation of e? studio — Additional Software

For more details on the installation of Additional Software, please see section 2.1.3.3.
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7. License Agreement

Read and accept the software license agreement. Click [Next >] button. Please note that user must
accept the license agreement, otherwise installation cannot be continued.

4 Renesas e* studio

Renesas e studio

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

@ Licenses

Setup m] X

setwp RLENESAS

Please read and accept the ing Software

Renesas e2 studio License Terms and Conditions for RENESAS e2 studio A
OpenJDK License Agreemen
ARM DS-5 Toolchain Integra
IAR Plugin Manager

This Renesas e2 studio license agreement ("Agreement”) is between the
entity on whose behalf you are entering into this Agreement ("Client")
and Renesas Electronics Corporation, a Japanese company with its
registered office at 3-2-24, Toyosu, Koto-ku, Tokyo 135-0061, Japan
("Renesas”). YOU SHOULD READ THIS AGREEMENT CAREFULLY, AS IT
CONSTITUTES A BINDING CONTRACT BETWEEN CLIENT AND RENESAS.
The Renesas IDE Software (defined below) is intended for commercial
use by a company or corporation only and is not designed, developed
or produced for any private use or purpose. If you are an individual, or
you intend to install the Renesas IDE Software on behalf of an individual,
or the Renesas IDE Software is expected to be used for a private
purpose directly or indirectly, you should click “No* on the installer.
Otherwise, by clicking the "l accept” button or other button or
mechanism designed to acknowledge agreement to the terms of an
electronic copy of this Agreement, or by installing, accessing, or
otherwise copying or using all or any portion of the Renesas IDE
Software, you accept this Agreement on behalf of the entity for which

< > | you are authorized to act (e.g., an employer) and acknowledge that such +

I [l accept the terms of the Software Agreements | Print all...

< Back Insta Cancel

Figure 7: Installation of e? studio — Licenses

8. Shortcuts

Select shortcut name for start menu and click [Next >] button to continue.

Note: If e? studio has already been installed in another location, it is recommended to rename the shortcut
to distinguish from the other e? studio(s).

A Renesas e? studio

Renesas e’ studio

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

e LENESAS

Shortcuts to important programs and files will be created in the following locations:

In start menu group: | Renesas Electronics 2 studio

) Restore Default

< Back Install Cancel

Figure 8: Installation of e? studio — Shortcuts
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9. Summary
Components list to be installed is shown. Please confirm the contents and click [Install] button to install
the Renesas e? studio IDE.

EA Renesas e* studio Setup [m] X

Renesas e? studio Setup RE N ESAS

N
Welcome Ready to install
Device Families Software to install:
ErtiaFoatines « Renesas e2 studio
« Java Runtime

Customise « AR Plugin Manager
Features * Renesas e2 studio Common Components (Lite)
* Renesas e2 studio Common Components (Full)
+ Renesas e2 studio Common Companents for ARM Devices
* Renesas e2 studio Tools
Licenses « Renesas RZ Family Support
« Renesas RZ Family Support (requiring .Net Framework)

Additional
Software

BT « Renesas FSP Smart Configurator Core
Drivers « Renesas FSP Smart Configurator ARM
« Renesas QF Common Components
@ Summary « ARM DS-5 Toolchain Integration

« Eclipse CDT Linker Script Editor and DSL
+ GCC for Renesas RZ Build Support
« GCC for Renesas RZ Support Files
+ Just) Adoptium Open)DK Hotspot JRE Complete
+ Renesas Build Support Files
+ Renesas CMake Build Support Files.
+ Renesas Common Project Import/Export
« Renesas Debug Views
i md ek L ey 2

< Back ] Next Install | Cancel

Figure 9: Installation of e? studio — Summary

10. Installing...
The installation will proceed. Depending on selected items of additional software, new dialog prompts
may appear during the installation process. Please see section 2.1.3.3 for more detailed information.

11. Results
Click [OK] button to complete the installation.

B Renesas e studio Setup [m] X
2 "
Renesas e’ studio Setup RE N E SAS

Welcome Installation of e2 studio is complete.
(L RIS Please click OK to close.
Extra Features

Customise [ Launch e2 studio?
Features View Release Notes?
Additional [] View What's New?
Software

Licenses

Shortcuts

Drivers

Summary

Installing...

@ Results

Back Next i

Figure 10: Summary Page
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2.1.3.3 Installation of Additional Software

As mentioned in section 2.1.3.2, the additional software listed below is essential for RZ/G FSP.

e GNU ARM Embedded 13.3-Rel1.

In this section, the detailed procedure for installing these tools.

¢ GNU ARM Embedded Toolchain 13.3-Rel1

If it was selected in the Additional Software pane of e? studio, you will see the installation wizard for the
GNU ARM Embedded Toolchain during the installation process.

{37 Arm GNU Toolchain 13.3.rel1 arm-none-eabi = X

Welcome to Arm GNU Toolchain
13.3.rell arm—none—eabi Setup

Setup will guide you through the installation of Arm GNU
Toolchain 13.3.rel1 arm-none-eabi.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

47 Arm GNU Toolchain 13.3.rel1 arm-none-eabi = X

License Agreement

Please review the license terms before installing Arm GNU Toolchain 13.3.rel1 k ) 7
arm-none-eabi.

Press Page Down to see the rest of the agreement.

“ontains code from project GNU Binutils (https: //www.anu.ora/software binutils ), A

(GNU Debugger (https: //www.gnu.org/software fadb/) under the following license(s).

GNU GENERAL PUBLIC LICENSE
Version 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

If you accept the terms of the agreement, dick I Agree to continue. You must accept the

| agreement to install Arm GNU Toolchain 13.3.rel1 arm-none-eabi.

< Back 1Agree | Cancel

{37 Arm GNU Toolchain 13.3.rel1 arm-none-eabi -

Choose Install Location
Choose the folder in which to install Arm GNU Toolchain 13.3.rel1 arm-none-eabi.

¥y

Setup will install Arm GNU Toolchain 13,3.rel1 arm-none-eabi in the following folder. To install
in a different folder, dick Browse and select another folder. Click Install to start the
installation.

Destination Folder

[ogram Fies (x85)¥Arm GNU Toolchain arm-none—eabi¥13.3 rel1| IR T 08
Space required: 1,1GB
Space available: 4.9 GB
<gack |__instal | Cancel

{37 Arm GNU Toolchain 13.3.rel1 arm-none-eabi -

Completing Arm GNU Toolchain
13.3.rell arm—none—eabi Setup

Arm GNU Toolchain 13.3.rel1 arm-none-eabi has been
installed on your computer,

Click Finish to dose Setup. 4

[J show Readme
[J Launch geevar.bat

[[] Add registry information

|

Figure 11: Installation of GNU ARM Embedded Toolchain
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2.1.4 e?studio installation for Linux PC
This chapter describes how to install the e? studio IDE on Linux PC.

2.1.4.1 Download

The following files are required to download before installation.

e SEGGER J-Link driver
Please choose the version VV7.96j or later and download Linux 64-bit DEB Installer at the URL below:
https://www.segger.com/downloads/jlink/

e ¢?studio IDE installer
e? studio IDE installer package can be downloaded from Renesas website for free. Please check
detailed information from: https://www.renesas.com/e? studio.

2.1.4.2 Installation

This section describes the procedure of each software installation.
Filename, version number and the file path are provided for example purpose only.

e SEGGER J-Link driver

1. Open a terminal window and enter commands stated below.
sudo dpkg -i JLink_Linux_V796j_x86_64.deb

(If the previous install fails with unmet dependencies, retry it as follows)
sudo apt-get -f install
sudo dpkg -i JLink_Linux_V796j_x86_64.deb

e e?studio IDE

1. Run the e? studio IDE Installer. (Before running the installer, check the execution permission of the
installer.)
Je2studio_installer-2025-01_linux_host.run

2. User needs to select Install Type as shown below.
In this material, it is expected that Custom Install will be selected.
Then, click [Next >] button to continue.

Renesas e studio setup

RENESAS

Please select the e* studio installation type. Click here for help selecting a type and to see what features are included.

Lite Install (Recommended)
hi

ard Install
2 studi

-1

Figure 12: Selection of Install Type
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3. Welcome page (Cont’d)
User can change the install folder by clicking [Change...] button.
Click [Next >] button to continue.

Note1: If you would like to have multiple versions of e? studio, please specify new folder here.
Note2: Multi-byte characters cannot be used for e? studio installation folder name.

Renesas e? studio Setup x

RLENESAS

Renesas e? studio Setup

Install directory ready

@ Welcome

Install Location:

Prerequisite software already installed

Change Proxy Settings...

Ready to install

Software to install:
* Renesas e2 studio
= Java Runtime
= IAR Plugin Manager
= Renesas e2 studio Common Components (Lite)
* Renesas e2 studio Common Components (Full)
* Renesas QE Common Components
= Eclipse CDT Linker Script Editor and DSL

camee

° Internet connection available

Figure 13: Installation of e? studio — Welcome page

4. Device Families
Select Devices Families to install. Click [Next >] button to continue.

Renesas e? studio Setup X
Renesas e® studio Setup
Select the device families you wish to install support for n tE N ESAS
Welcome AW RA
. o RA Build, Debug & Code Generation support for Renesas RA devices
@ Device Families ;
AW RZ
Rz : :
Build, Debug & Code Generation support for Renesas RZ devices

FM\ RL78
RU78 Build, Debug & Code Generation support for Renesas RL78 devices
@\ RX

RX Build, Debug & Code Generation support for Renesas RX devices
@\ RH850

RHB50 Build, Debug & Code Generation for Renesas RH850 devices

s
Re Build & Debug support for Renesas RE devices

@ Linux on Renesas RZ

—

Figure 14: Installation of e? studio — Device Families
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5. Extra Features
Select Extra Features (e.g., Language packs, SVN & Git support...) to be installed.

For non-English language users, please select Language packs at this step if needed.

Then, click [Next >] button to continue.

Renesas e? studio Setup X
Renesas e’ studio Setup
Select the extra features you wish to install u (E N ESAS
Welcome @) Japanese Language Support
Device Families 3
@ Extra Features ,L’_r‘\ Chinese (Simplified) Language Support
(=)
u- ; Chinese (Traditional) Language Support
= Git Integration
(&) )
= Git SCM Support
- Terminals
(=)
— ANSI/vt102 compatible Terminal support for Serial, ssh and Telnet
Select All

SBnck £anesl

Figure 15: Installation of e? studio — Extra Features

6. Customize Features

Select the components to install and click [Next >] button to continue. Be sure that Renesas FSP

Smart Configurator Core and Renesas FSP Smart Configurator ARM are selected.

Renesas e? studio Setup x

RENESAS

Renesas e? studio Setup

Welcome Select the components you want to install.

Device Families < (JRenesas DA Family Support (24.10.0.R20241003-1714)

Extra Features
Renesas FSP Smart Configurator Core (10.0.0.v20240930-1428)

Customise )
Features Renesas FSP Smart Configurator ARM (10.0.0.v20240924-1500)

¢ (0 F.-‘tenesas. RISC-VIMCU Support (24,10.0‘F\2.0241003-1714]

¢ (¥] Renesas QE CO;anﬂ Ccm;aor‘\ents.(ln‘10.0&20241003-1714) o
Oeit ir;tegratlc.n f.t.Jr Eclips.e. (6.10.0.202406032230-1)

< (] Additional Tools (24.1‘0.0‘R20.241003-1714) 7

@™ Te.rmin;“ll (4.6.0)

Select All Optional Deselect All Optional

Size of install: 835.4 MB

< Back Cancel

Figure 16: Installation of e? studio — Customize Features
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7. Additional Software

Select the additional software (i.e., compilers, utilities, QE...) to be installed.
Be sure to select the “GNU ARM Embedded 13.3-Rel1” and click [Next >] button to continue.

Renesas e* studio

Renesas e? studio Setup X

Setup

Select the additional software you wish to install

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

RENESAS

Renesas QE

~ (@ Renesas Al
Renesas Al Navigator 1.2.0
& Al Transfer Learning Tool Plugin 1.2.0
3 Al Model Conversion Tool Plugin 1.2.0

Renesas Toolchains && Utilities

~ [ GCC Toolchains && Utilities
[ GNU ARM Embedded 13.3-Rell 13.3.1.arm-13-24 1.0 GB
GNU ARM Embedded 12.2-Rell 12.2.1.arm-12-24 1000 B

GCC ARM A-Profile (AArch64 bare-metal) 13.2.Rell 13.2.1.20231009 1000 BI

GCC ARM A-Profile (AArch64 bare-metal) 10.3 2021.07 10.3.0.2021-07 1000 B

Renesas RA FSP

375.0 MB download required

Siack cancel

Figure 17: Installation of e? studio — Additional Features

8. License Agreement

Read and accept the software license agreement. Click [Next >] button to continue.

Please note that the user must accept the license agreement, otherwise installation cannot be

continued.

Renesas e* studio

Welcome
Device Families
Extra Features

Customise
Features

Additional
Software

@ Licenses

Renesas e’ studio Setup x

Setup

RENESAS

Please read and accept the following Software Agreements

Renesas e2 studio
OpenJOK License Agreem
ARM DS-5 Toolchain Integ
IAR Plugin Manager

License Terms and Conditions for RENESAS e2 studio

This Renesas e2 studio license agreement ("Agreement") is
between the entity on whose behalf you are entering into this
Agreement ("Client") and Renesas Electronics Corporation, a
Japanese company with its registered office at 3-2-24, Toyosu,
Koto-ku, Tokyo 135-0061, Japan ("Renesas"). YOU SHOULD READ
THIS AGREEMENT CAREFULLY, AS IT CONSTITUTES A BINDING
CONTRACT BETWEEN CLIENT AND RENESAS.

The Renesas IDE Software (defined below) is intended for
commercial use by a company or corporation only and is not
designed, developed or produced for any private use or
purpose. If you are an individual, or you intend to install the
Renesas IDE Software on behalf of an individual, or the Renesas
IDE Software is expected to be used for a private purpose
directly or indirectly, you should click “No* on the installer.
Otherwise, by clicking the "l accept" button or other button or
mechanism designed to acknowledge agreement to the terms of
an electronic copy of this Agreement, or by installing, accessing,
or otherwise copying or using all or any portion of the Renesas

I 31 accept the terms of the Software Agreements I Print all...

S -] S

Figure 18: Installation of e? studio — Licenses
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9. Shortcuts
Select shortcut name for start menu and click [Next >] button to continue.

Note: If €% studio was installed in another location, it is recommended to rename to distinguish from the other

e? studio(s).

Renesas e” studio Setup X
Renesas e* studio Setup
RENESAS
Welcome Shortcuts to important programs and files will be created in the following locations:

Device Families
In the application launcher

Extra Features

Customise
Features

Additional
Software

Licenses

@ Shortcuts

bilis S

Figure 19: Installation of e? studio — Shortcuts

10. Summary

Components list to be installed is shown. Please confirm the contents and click [Install] button to

install the Renesas e? studio IDE.

(] Renesas e* studio 2024-07 Setup [=]E3]
Renesas @ studio 2024-07 Setup
RENESAS
Welcome Ready to install
Device Families Software to install:
* Renesas o2 studio v24.7.0.R20240620-1807
Extra Features

= Java Runtime v17.0.0

Customise * 1AR Plugin Manager v1.1.0.202007251457

Features * Renesas e2 studio Common Components (Lite) v24.7.0.R20240620-1807
* Renesas o2 studio Common Companents (Full) v24.7.0.R20240620-1807

Additional * Renesas e2 studio Common Components for ARM Devices

Software v24.7.0.R20240620-1807

Kt * Renesas o2 studio Tools v24.7.0.R20240620-1807
= Renesas RZ Family Support v24.7.0.R20240620-1807

shortcuts * Renesas FSP Smart Configurator Core v9.6.0.v20240619-0945
* Renesas FSP Smart Configurator ARM v9.6.0.v20240619-1422

@ Summary + Renesas QE Common Components v24.7.0.R20240620-1807

* ARM D5-5 Toolchain Integration v1.0.5.v20240408-1026

= Eclipse COT Linker Script Editor and D5L v1.0.112.vw20240408-2044

= GCC for Renesas RZ Build Support v24.7.0.v20240613-0901

= GCC for Renesas RZ Support Files v24.7.0.v20240513-0255

* Just] Adoptium OpenjDK Hotspot JRE Complete v17.0.10.v20240120-1143
= Renesas Build Support Files v9.6.0.v20240408-1639

* Renesas CMake Build Support Files v9.6.0.v20240408-1639

* Renesas Common Project Import/Export w9.6.0.v20240606-0906

* Renesas Debug Views v3.6.0.v20240607-0813

* Renesas Debug Views (Lite) v9.6.0.v20240607-0813

* Renesas QE common v2.2.2.v20240408-1831

» Renesas RTOS Debug Views v5.6.0.v20240530-1615

» Renesas RZ Debug Support v24.7.0.v20240408-2031

* Renesas RZ Debug Support Files v24.7.0.v20240622-0251

» Renesas Smarnt Configurator for RZ v24.7.0.v20240620-0854

* Renesas Smart Help v9.6.0.v20240521-0307

* Renesas 2 studio ARM Commeon Debug v9.6.0.v20240520-0B40

* Renesas e2 studie ARM Commen GCC Build v0.6.0.v20240520-0840

S8k S ﬁ

Figure 20: Installation of e? studio — Summary
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11. Installing...
The installation is performed. Depending on selected items of additional software, new dialog
prompts may appear during the installation process.

12. Results
Click [OK] button to complete the installation.

Renesas e® studio Setup
RENESAS
Welcome Installation of e2 studio is complete.
Device Families Please click OK to close.
Extra Features
Customise
Features :
Additional V]
Software
- Useful Links:
Licenses
Shortcuts
Summary
Installing...
@ Results

- “

Figure 21: Installation of e? studio — Results
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2.2 FSP setup
2.2.1 |Installation of FSP using Package Installer

Package Installer RZG_FSP_Packs_v3.1.0.exe is showcased at here. This section describes the procedure

for installation. Note that it's for Windows Host PC only.

1. Quit €? studio.
2. Invoke RZG_FSP_Packs_v3.1.0.exe.
3. Click [Next >] button to start the installation.

& Renesas RZG FSP = X

Renesas Flexible Software Package
(FSP) Installer

This installer wil install FSP packs and documentation into an
existing e2 studio installation.
The documentation will be available at

<INSTALL_DIRECTORY >/fsp_documentation frzg/<VERSION

The source for FSP can be found at
hittps: //github.com frenesas frzg-fsp

e

Figure 22: FSP Package Installer

4. See the license term and click [I Agree] button if it's acceptable.

{# Renesas RZG FSP - x

RZG FSP

aRENES/AS  rlease review the icense terms before instaling Renesas R2G
FSp

If you accept all terms of the agreement, dick I Agree.

o ] (oo

Figure 23: FSP License Term
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Package

5. Specify e? studio installation folder (e.g., C:\Renesas\e? studio) and click [Install] button.

(& Renesas RZG FSP

C:¥Renesas¥e2_studo).

Space requred: 54.0 MB
Space avaiable: 21.4GB

C:¥Renesas¥e? studio

X

Choose Install Location

aRENES/AS  Ohoose the folder in which to nstal Renesas RZG FSP

The installation path must point to the root of the e2 studio installation (e.g.

Please make sure e2 studio is dosed before instalation.

Browse to folder where e2 studio is installed

Browse...

Cancel

<o | ]

Figure 24: Browse to

the folder where e? studio is installed

6. Click [Finish] button to complete the installation.

(37 Renesas RZG FSP

Completing Renesas RZG FSP
Setup

Renesas RZG FSP v3.1.0 has been installed on your
computer.

Click Finish to cose Setup.

Open up documentation for this release

Click here to visit the FSP GitHub repository

Finish

Figure 25: Completion of FSP Installation

If the box Open up documentation for this release is checked at that time, FSP documentation for the

installed version of FSP should be opened.

RO1AN5924EJ0310 Rev.3.10
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2.2.2 Installation of FSP Packs using Package Zip file

No package installer is available for Linux Host PC. Thus, you need to install FSP with the zip file
RZG_FSP_Packs_v3.1.0.zip. This section describes the procedure for installation.

1. Download RZG_FSP_Packs_v3.1.0.zip from here.
2. Extract the zip file to €? studio installation directory. If it's successfully extracted, rz_fsp/rzg/packs should
be placed at <e2 stduio installation directory>/Internal/projectgen.

(C:) Windows > Renesas > e2_studio >| intemal > projectgen » rzfsp » rzg > packs

Name -
Amazon.FreeRTOS-Kernel.11.1.0+fsp.3.1.0.pack
Am.CMSISE.6.1.0+fsp.3.1.0.pack
Arm.CMSIS-DSP.1.16.2+f5p.3.1.0.pack
Arm.CMSIS-NN.6.0.0+fsp.3.1.0.pack
Linaro.OpenAMP.1.0.0+fsp.3.1.0.pack
Renesas RZG.3.1.0.pack
RenesasRZG_baremetal_blinky.3.1.0.pack
Renesas RZG_baremetal_blinky_g3e.3.1.0.pack
Renesas RZG_baremetal_blinky_g3e_ca35clackup.3.1.0.pack
Renesas RZG_baremetal_blinky_g3e_cm33boot.3.1.0.pack
Renesas RZG_baremetal_blinky_g3s.3.1.0.pack
Renesas RZG_baremetal_minimal_g3e.3.1.0.pack
Renesas RZG_baremetal_minimal_g3e_caSSclkup.3.1.0.pack
Renesas RZG_baremetal_minimal_g3e_cm33boot.3.1.0.pack
Renesas.RZG_baremetal_minimal_g3s.3.1.0.pack
Renesas.RZG_board_custom.3.1.0.pack
Renesas.RZG_board_rzg2|_smarc.3.1.0.pack
Renesas RZG_board_rzg2le_smare.3.1.0.pack
Renesas.RZG_board_rzg2ul_smare.3.1.0.pack
Renesas RZG_board_rzg3e_evk.3.1.0.pack
R RZG_board_rzg3e_evk_caSSclockup.3.1.0.pack
R RZG_board_rzg3e_evk_cm33boot.3.1.0.pack

RenesasRZG_board_rzg3s_smarc3.1.0.pack
Renesas.RZG freertos_blinky.3.1.0.pack

Renesas.RZG freertos_blinky_gle.3.10.pack

Renesas.RZG freertos_blinky_gle_caSSclkup.3.1.0.pack
Renesas.RZG_freertos_blinky_gle_cm33boot.3.1.0.pack
Renesas RZG_freertos_blinky_g3s.3.1.0.pack

R RZG_freertos_minimal_g3e.3.1.0.pack

Renesas.RZG_freertos_minimal_gde_caSSclkup.3.1.0.pack
Renesas.RZG_freertos_minimal_g3e_cm33boot.3.1.0.pack
Renesas.RZG freertos_minimal_g3s.3.1.0.pack
Renesas.RZG_mcu_rzg2l.3.1.0.pack
Renesas.RZG_mcu_rzg2ul 3.1.0.pack
Renesas.RZG_mcu_rzg3e.3.1.0.pack
Renesas.RZG_mcu_rzg3s.3.1.0.pack

SEGGER. Link.7.96.10.pack

Figure 26: FSP Packs on e? studio installation directory

3. Atthe 1st invocation of e? studio after the extraction, FSP should be automatically installed.
4. You can check if the installation is successfully done by the procedure below:
e Click Help > CMSIS Packs Management > Renesas RZ/G

Figure 27: CMSIS Packs Management (1)

e |If FSP is successfully installed, 3.1.0 should be listed under FSP as shown below:
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B CMSIS Packs Management - Renesas RZ/G O X
Packs location:
Show in System Explorer,
Available Packs =l = e
Category Version Status
v [E) Fsp
W l0
: Generic

Figure 28: CMSIS Packs Management (2)

3. Set up a SMARC EVK
3.1 RZ/G2L SMARC EVK

Below is an example of a typical system configuration.

e’ studio

| —HE—+

SEGGER J-Link 1)

(*1) J-Link 9-pin Adapter ~ RZ/G2L SMARC EVK

Figure 29: System Configuration Example — RZ/G2L SMARC EVK

3.1.1 Supported Debugger
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.1.2 Board Setup
3.1.21 Boot MODE

To set the board to Boot mode 3(QSPI Boot (1.8V) Mode), set the SW11 as below.
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SW11:Mode Setting switch

DIP-Switch-4pol-SMD

(%]

i, S 8 BOOT_SELO#
2 Lo 7 BOOT_SELT#
3 = 3 BOOT_SEL2¢
= 5 VBUS_MIN

SCIF Download mode QSPI Boot (1.8V) Mode
BOOT/Power Mode Select BOOT/Power Mode Select

1ge R

:|“*.I.

eMMC Boot (1.8V)Mode
BOOT/Power Mode Select BOOT/Power Mode Select

TIL L

!

(*1) SCIF boot mode is the mode used for writing such as u-boot.
This mode that operates only with the built-in ROM and can be used for minimum board confirmation
See section "How to check the operation of the board”.

Figure 30: Boot MODE
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3.1.2.2 JTAG connection
When connecting JTAG, you must set the DIP SW1 settings as follows:

CN2 : JTAG 10pin ARM standard connector

ARM Cortex Micro
JTAG / SWD 0.05" pitch

10pin Ribbon Cable

CN1 is a connector for analog signal input. Please careful not to accidentally connect
the JTAG cable.

m microSD/eMMC selection
OFF JTAG debug mode OFF Select eMMC on SMARC Module
ON Normal operation ON Select microSD slot on SMARC Module

The selection of microSD slot and eMMC on the SMARC module is exclusive.

Figure 31: JTAG connection

Please note that RZ/G2L SMARC EVK has CoreSight 10 connector and therefore, the following adapter
must be needed to connect Segger J-Link.

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/

3.1.2.3 Debug Serial (console output)
Debug serial uses CN14. The baud rate is 115200bps.

CN14 : USB Type-microB Connector used as SCIF3

I
1
I To PC
I
I

USB Type-microB cable

CN14:USB Type-microB Connector

Figure 32: Debug Serial (console output)
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3.1.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Ill 65W Pod (manufactured by Anker)

I CN6 : USB Type-C Connector for Power Supply
1

To USB-PD
. «aam- Power Charger

USB Type-C cable

Figure 33: Power Supply

Connect USB-PD Power Charger to USB Type-C Connector. Then LED1(VBUS PWR On) and LED3
(Module PWR On) light up. Press SW9 to turn on the power. Then LED4(Carrier PWR On) lights up.

Figure 34: LED Status after Turning on EVK
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3.1.2.5 How to check the operation of the board

First, check the board for problems. There are two ways to do this. Please check with either.

BOOT MODE: QSPI Boot (1.8V) Mode

If u-boot is written to the serial flash, When the power is turned on, the following will be output to the console

(CN14).

" COMAJE - Tera Term VT

0.10 (Feb 11 2021

- 10:18:3

BOOT MODE: SCIF Download Mode

When the power is turned on, the following will be output to the console (CN14).

¥ COM4E - Tera Term VT
PR BEE E

) IYRO-MO)  DYEOW) ALTH)

RO1AN5924EJ0310 Rev.3.10
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3.2 RZ/G3S SMARC EVK

Below is an example of a typical system configuration.

e? studio

SEGGER J-Link (*1)

(*1) J-Link 9-pin Adapter RZ/G3S SMARC EVK

Figure 35: System Configuration Example — RZ/G3S SMARC EVK

3.21 Supported Debugger
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.2.2 Board Setup
3.2.2.1 Boot MODE

Set the boot mode using the two DIP SWITCHs shown in the figure below.

Figure 36: Boot MODE

In SW_CONFIG, select the boot CPU with the following settings.

1 2 3 4 5 6
OFF OFF ON OFF OFF ON: CM33 boot
OFF: CA55 boot
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In SW_MODE, select the boot device with the following settings.

¢ Boot Mode 1: Booting from eMMC

1 2 3 4

ON OFF OFF ON
e Boot Mode 2: Booting from serial flash memory

1 2 3 4

OFF OFF OFF ON

e Boot Mode 3: Booting from the program downloaded through the serial communications with FIFO
(SCIF)

1 2 3 4
OFF ON OFF ON

3.2.2.2 JTAG connection
For JTAG connection, connect the included “SMARC JTAG ADAPTOR” to the board.

ARM Cortex Micro

JTAG / SWD 0.05" pitch
10pin Ribbon Cable

——
connect

Figure 37: JTAG connection

Please note that RZ/G3S SMARC EVK has CoreSight 10 connector and therefore, the following adapter
must be needed to connect Segger J-Link.

https://www.segger.com/products/debug-probesi/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.2.2.3 Debug Serial (console output)
Debug serial uses SER3_UART (SCIFA ch0). The baud rate is 115200bps.

To PC

USB Type-microB cable

210

SER3_UART =
¥ —

connect

Figure 38: Debug Serial (console output)
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3.2.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Ill 65W Pod (manufactured by Anker)

To USB-PD
ﬁam- Power Charger

USB Type-C cable

Figure 39: Power Supply

Connect USB-PD Power Charger to USB Type-C Connector. Then VBUS ON and SOM ON light up. Press
POWER to turn on the power. Then CARRIER ON lights up.

= CARRIER ON
LED

S =

~
s

o

2iid

Figure 40: LED Status after Turning on EVK
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3.2.2.5 How to check the operation of the board

First, check the board for problems. There are three ways to do this. Please check with any of them.

BOOT MODE1: Booting from eMMC

If u-boot is written to the eMMC, When the power is turned on, the following will be output to the console

(SER3_UART).

¥ COM4 - Tera Term VT
File Edit Setup Control Window KanjiCode Help

U-Boot

CPU:
Mode | :
DRAM:
MMC -

In:
Out
Err:

Net :
Error:

NOTICE:
NOTICE:
NOTICE:
NOTICE:
NOTICE:

BL2: v2.7(release):2.7.0/g3s_1.0.0_rc3
BL2: Built : 14:34:44, Nov 2 2023
BL2: Booting BL31

BL31: v2.7(release):2.7.0/23s_1.0.0_rc3
BL31: Built : 14:34:44, Nov 2 2023

2021.10 (Oct 25 2023 - 08:58:16 +0000)

Renesas Electronics CPU rev 1.0

smarc-rzgds

896 MiB

sd@11c00000: 0, sd@11c10000: 1, sd@11c20000: 2

Loading Environment from MMC... OK

serial@1004b800
serial@1004b800
serial@1004b800

ethernet@®11c30000 address not set.

No ethernet found.

Hit any key to stop autoboot: 0

Card did not respond to voltage select! : -110
Card did not respond to voltage select! : -110
Couldn’t find partition mmc 1:1

Can’t set block device

Card did not respond to voltage select! : -110
Couldn’t find partition mmc 1:1

Can’t set block device
Bad Linux ARM64 Image magic!
=> *

BOOT MODEZ2: Booting from serial flash memory

If u-boot is written to the serial flash, When the power is turned on, the following will be output to the console

(SER3_UART).

] COM4 - Tera Term VT
File Edit Setup Control Window KanjiCode Help

U-Boot

CPU:
Mode | :
DRAM:
MMC -

In:
Out:
Err:
Net :
Error:

Couldn

Couldn

NOTICE:
NOTICE:
NOTICE:
NOTICE:
NOTICE:

BL2: v2.7(release):2.7.0/g3s_1.0.0_rc3
BL2: Built : 14:34:44, Nov 2 2023
BL2: Boot ing BL31

BL31: v2.7(release):2.7.0/83s_1.0.0_rc3
BL31: Built : 14:84:44, Nov 2 2023

2021.10 (Oct 25 2023 - 08:58:16 +0000)

Renesas Electronics CPU rev 1.0

smarc-rzgds

896 MiB

sd@11c00000: 0, sd@11c10000: 1, sd@11c20000: 2

Loading Environment from MMC... OK

serial@1004b300
serial@1004b800
serial@1004b800

ethernet@11c30000 address not set.

No ethernet found.

Hit any key to stop autoboot: 0

Card did not respond to voltage select! : -110
Card did not respond to voltage select! : -11
't find partition mmc 1:1

Can’t set block device

Card did not respond to voltage select! : -110
't find partition mmc 1:1

Can’t set block device

Bad Linux ARMG64 Image magic!

=> *
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BOOT MODES: Booting from the program downloaded through the serial communications with FIFO (SCIF)
When the power is turned on, the following will be output to the console (SER3_UART).

“ COM4 - Tera Term VT - O X
File Edit Setup Control Window KanjiCode Help
SCI Download mode (Normal SCI boot) ~
i- Load Program to SRAM ---------------
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3.3 RZ/G3E SMARC EVK

Below is an example of a typical system configuration.

e? studio

SEGGER J-Link (*1)

(*1) J-Link 9-pin Adapter RZ/G3E SMARC EVK

Figure 41: System Configuration Example — RZ/G3S SMARC EVK

3.3.1 Supported Debugger
e SEGGER J-Link

For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER — the Embedded Experts.

3.3.2 Board Setup
3.3.2.1 Boot MODE

Set the boot mode using the two DIP SWITCHs shown in the figure below.

Figure 42: Boot MODE

In SWS5, select the boot CPU with the following settings.

1 2 3 4 5 6

OFF ON: CM33 boot ON OFF OFF OFF
OFF: CA55 boot

RO1AN5924EJ0310 Rev.3.10
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In SW_MODE, select the boot device with the following settings.

Boot Mode 3: Booting from SCIF download

1 2 3

OFF ON OFF
¢ Boot Mode 4: Booting from USB download

1 2 3

ON ON ON
e Boot Mode 5: Booting from eMMC 1.8 V

1 2 3

ON OFF OFF

Boot Mode 6: Booting from a serial flash memory connected to the xSPI bus space 1.8 V

1

2

3

OFF

ON

OFF

3.3.2.2 JTAG connection
For JTAG connection, connect the included “Breakout board” to the board.

connect

ARM Cortex Micro
JTAG / SWD 0.05" pitch
10pin Ribbon Cable

Figure 43: JTAG connection

Note1: RZ/G3E SMARC EVK has CoreSight 10 connector. Therefore, the following adapter must be needed

to connect Segger J-Link.
https://www.segger.com/products/debug-probesi/j-link/accessories/adapters/9-pin-cortex-m-adapter/

Note2: It is strongly recommended that do not detach the breakout board once it is connected to the CN1
connector on the module board.
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3.3.2.3 Debug Serial (console output)
Debug serial uses Debug_UART (SCIFA ch0). The baud rate is 115200bps.

USB Type-microB cable

connect

Figure 44: Debug Serial (console output)
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3.3.2.4 Power Supply

Here are the power supply related goods to be used in Renesas’ development. Please prepare for the
equivalent ones for your development.

e USB Type-C cable CB-CD23BK (manufactured by Aukey)
e USB PD Charger Anker PowerPort Ill 65W Pod (manufactured by Anker)

Yoy To USB-PD
mm- Power Charger

USB Type-C cable

Figure 45: Power Supply

Connect USB-PD Power Charger to USB Type-C Connector. Then VBUS ON and SOM ON light up. Press
POWER to turn on the power. Then CARRIER ON lights up.

CARRIER ON
LED

Figure 46: LED Status after Turning on EVK
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3.3.2.5 How to check the operation of the board

First, check the board for problems.

BOOT MODES3: Booting from the program downloaded through the serial communications with FIFO (SCIF)
When the power is turned on, the following will be output to the console (SER3_UART).

T COM12 - Tera Term VT - O X

Eile Edit 5Setup Control Window Help

RO1AN5924EJ0310 Rev.3.10 Page 36 of 72
July.22.25 RENESAS




RZ/G2L RZ/G2LC RZ/G2UL RZ/G3S RZ/G3E
Getting Started with Flexible Software Package
4. Tutorial: Your First RZ MPU Project - Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of
creating a simple application using e? studio and running that application on an RZ MPU board.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microprocessors. If the LED blinks you know that:
e The toolchain is setup correctly and builds a working executable image for your chip.
e The debugger has installed with working drivers and is properly connected to the board.
e The board is powered up and its jumper and switch settings are probably correct.
o The microprocessor is alive, the clocks are running, and the memory is initialized.
e Timer (GTM) interrupt is intentionally fired and GPIO is properly controlled.
Note: SMARC EVK board does not have any LED.

Thus, Blinky sample application used in this tutorial is designed to use the Pmod module described
below alternatively:

e Pmod LED (Four High-brightness LEDSs): https://reference.digilentinc.com/pmod/pmodled/start

This module is not included on the SMARC EVK board and so, please prepare it beforehand.
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Pmod1
RZ/G2L SMARC EVK

PMOD1_3A

RZ/G3S SMARC EVK

Figure 47: Connection Pmod LED module to RZ/G2L or RZ/G3S

RZ/G3E SMARC EVK PMOD1_3A

Figure 48: Connection Pmod LED module to RZ/G3E
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4.3 Create a New Project for Blinky

The creation and configuration of an RZ/G C/C++ FSP Project is the first step in the creation of an
application. The base RZ/G pack includes a pre-written Blinky example application.

Follow these steps to create an RZ MPU project:

1. In e? studio, click File > New > C/C++ Project.

B work - ¥ studio

File Edit Source Refactor Navigate Search Project Renesas Views Run Window Help
New Alt+Shift=N > Renesas C/C++ Project g
Open File... [ Makefile Project with Existing Code

3 Open Projects from File System... & C/C++ Project N

Recent Files > % Project..

2. Select [Renesas RZ] > [Renesas RZ/G C/C++ FSP Project] and Click [Next >] button.

Figure 49: New C/C++ Project

& New C/C++ Project (=] X

Templates for New C/C++ Project

All GNU for Renesas RZ C/C++ Executable Project ~
CMake FEImN A C/C++ Executable Project for Renesas RZ using the
GNU ARM Embedded toolchain.

GNU for Renesas RZ C/C++ Library Project
EEZmN A C/C++ Library Project for Renesas RZ using the GNU
ARM Embedded toolchain.

Renesas RZ/A C/C++ FSP Project
FS==m~. Create an executable or static library C/C++ FSP
project for Renesas RZ/A.

“Renesas RZ/G C/C++ FSP Project |
FS="=™ Create an executable or static library C/C++ FSP
project for Renesas RZ/G.

FE===~ Create an executable or static library C/C++ FSP
nenioct for Ronecac R7 /N

? Back Next > Fir Cancel

Figure 50: Renesas RZ/G C/C++ FSP Project

3. Assign a name to this new project. Blinky is a good name to use for this tutorial.
4. Click [Next >] button. The Project Configuration window shows your selection.
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{8 Renesas RZ/G C/C++ FSP Project

Renesas RZ/G C/C++ FSP Project

Project Name and Location

Project name

| [3inky |

Use default location

C\workspace\Blinky

You can download more Renesas packs here

(%)

< Back

Cancel

Figure 51 : e? studio Project Configuration window (part 1)

5. Select the board support package by selecting the name of your board from the Device Selection drop-

down list. Select GNU ARM Embedded in Toolchains and version is 13.3.1 arm-13-24 and

click [Next >] button.

B Renesas RZ/G C/C++ FSP Project

Renesas RZ/G C/C++ FSP Project

Device and Tools Selection

Device Selection

7SP Version: [3.1.0 -]
Board: RZ/G2L Evaluation Kit (SMARC)

Device: RIAD7GO44L23GBG_CM33

Core: Cortex-M33

language: @C OC++

IDE Project Type
e* studio managed build

Toolchains
GNU ARM Embedded

|13.3Al.alm-13-24 v Manage Toolchain:

Board Description

Device Details

TrustZone
Pins
Processor

Debugger
J-Link ARM

No
456
Cortex-M33

Cancel

Figure 52 : e? studio Project Configuration window (part 2)
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6. (Optional) When creating an RZ/G3E project, support for CM33 cold boot is also available. For further

information, refer to the RZ/G Multi-OS Package documentation.

@ Renesas RZ/G C/C++ FSP Project u]

Renesas RZ/G C/C++ FSP Project

Device and Tools Selection

Device Selection

. .| Board Description
ERS N 2/ G2. Evaluation Kit (SMARC) [+]
D User Board (for RZ/G3E) L
Sy User Board (for RZ/G3S)
Core: ‘CATED: Custom User Board (Any Device)
PLC Evaluation Kit (SMARC)
Language: fL Evaluation Kit (SMARC) Device Details
PUL Evaluation Kit (SMARC) TrosiZ N
}E Evaluation Board Kit (SMARC) Lo 9
JE Evaluation Board Kit (SMARC) - Cortex-AS Pins 456
|)E Evaluation Board Kit (SMARC) - Cmtex-M Processor Cortex-M33
b5 Evaluation Kit (SMARC)
v
< >
IDE Project Type Debugger
” studio managed build ~ JLink ARM
Toolchains
GNU ARM Embedded
133.1.arm-13-24 v Manage Toolchains,

Figure 53: e? studio Project Configuration window (part 3)

7. (Optional) When creating RZ/G Multi-Core project, choose the right bundled project as Preceding

Project, click [Next >] button.

B Renesas RZ/G C/Co FSP Project o X

Renesas RZ/G C/C+ + FSP Project

Preceding Project or Smant Bundie Selection

® None Choase this option when creating a project for the primary processor core (no preceding project or Smart Bundle)

Preceding Project

Smart Bundle:

Preceding Project/Smart Bundie Details

< <pack [[Hew> 7] Cancel

Figure 54: e? studio Project Configuration window (part 4)
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7. Select the build artifact and RTOS. Be sure that Secure must be chosen at the Sub-core start state on
the current version. Otherwise, the created project can’t be built successfully.

{8 Renesas RZ/G C/C++ FSP Project a X

Renesas RZ/G C/C++ FSP Project

Build Artifact, RTOS Selection and Sub-Core Selection

Build Artifact Selection RTOS Selection
@ Executable No RTOS X
® Project builds to an executable file

() Static Library
® Project builds to a static library file

) Executable Using an RZ/G Static Library
e Project builds to an executable file
* Project uses an existing RZ/G static library project

Sub-core start state

@ Secure
e Start sub-core in secure state

() Non-secure
e Start sub-core in non-secure state

( ? < Back Finish Cancel

Figure 55 : e? studio Project Configuration window (part 4)

8. Select the Blinky template for your board and click [Finish] button.

Renesas RZ/G C/C++ FSP Project O
8 j

Renesas RZ/G C/C++ FSP Project

Project Template Selection

Project Template Selection

®© " Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and
the C runtime environment.

[Renesas.RZG.3.0.0.pack]

G " Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.
[Renesas.RZG.3.0.0.pack]

Code Generation Settings
[#] Use Renesas Code Formatter

.?, < Back Next Cancel

Figure 56 : e? studio Project Configuration window (part 4)
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Once the project has been created, the name of the project will show up in the Project Explorer window
of e? studio. Now click [Generate Project Content] button in the top right corner of the Project
Configuration window to generate your board specific files.

o¢ [Blinky] FSP Configuratio

n

Summary Generate Project Content

Project Summary A
RENESAS
Board: RZ/G3E Evaluation Board Kit (SMARC) - Cortex-M33 cold boot
Device: RIAIGO4TESTGBG
Core: Cortex-M33
Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version: 310
Project Type: Flat
Figure 57 : e? studio Project Configuration tab
Your new project is now created, configured, and ready to build.
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4.3.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from templates,
and generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project
Content button, all the files necessary for the inclusion of that module into the project will be copied or
created. If that same check box is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e? studio for the Blinky application. The clock
configuration tab (see 5.2.3 Configuring Clocks) shows the Blinky clock configuration. The Blinky clock
configuration is stored in the BSP clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e? studio for the
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components
The Blinky project automatically selects the following HAL components in the Components tab:

e r_gtm

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL window
for the respective driver (see 5.2.8.Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in <project>/rzg_gen/main.c. It is one of the files that are generated during the
project creation stage and only contains a call to hal_entry(). For more information on generated files, see
Adding and Configuring HAL Drivers.

4.3.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e? studio when you select the
Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:

Get the LED information for the selected board by bsp_leds_t structure.

Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired.
Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.
Toggle the LEDs by writing to the GPIO pin with “R_BSP_PinWrite((bsp_io_port_pin_t) pin,
pin_level)” in callback function of GTM that is called with the specified interval.

POON -~
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4.4 Build the Blinky Project
Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:
1. Click on Project in the menu bar and select Build Project.

2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

a work - Blinky/configuration.xml - €* studio

[P ]s
& || % || ® | |3 Debug v || 7 Blinky Debug_Flat
=

L~ ‘%*

File Edit Navigate Search enesas Views Run  Windov

a. Project -> Build Project

Pl Project Explorer X

c. Right click -> Build Project

Project Summan

Board:
Device:
Toolchain:

Figure 58 : e? studio Project Explorer window

Once the build is complete, a message is displayed in the build Console window that displays the final image
file name and section sizes in that image.

[Z Pin Conflicts _ Console X

|CDT Build Conscle [Blinky]
"arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+notp -tdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnostics-pa
‘arm-none-eabi-gcc -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gce -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
‘arm-none-eabi-gce -mthumb -mcpu=cortex-m33+nodsp+nofp -fdiagnestics-pa
arm-none-eabi-gec @"Blinky.elf.in™
arm-none-gabi-cbjcopy -0 srec “"Blinky.elf" "Blinky.srec”
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4812 2872 16784384 16791188 1883694 Blinky.elf

@5:35:14 Build Finished. @ errors, @ warnings. (tock 7s5.823ms)

Figure 59 : e? studio Project Build console
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4.5 Debug the Blinky Project
4.5.1 Debug prerequisites

To debug the project on a board, you need
e The board to be connected to e? studio
e The debugger to be configured to talk to the board

e The application to be programmed to the microprocessor

Applications run from the internal ram or external ram of your microprocessor. To run or debug the
application, the application must first be programmed to ram by JTAG debugger. SMARC EVK board has a
JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug steps
To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run Window Help
Renesas Device Partition Manager
@ Tracex >
& Tracealyzer >
@ Run Crl+F11
%, Debug F11
Run History
© Runas
Run Configurations.
Debug History >
45_Debug As >
ebug Configuration:

Figure 60 : e? studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger Configurations ...

-:“:(J» y~:C

Debug As >

Debug Configurations...

Organize Favorites.

Figure 61 : e? studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking
New icon in the top left corner of the window. Once selected, the Debug Configuration window displays
the Debug configuration for your Blinky project.

Figure 62 : e? studio Debugger Configurations window with Blinky project (1)
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3. Select the debug configuration for the generated project and select the Debugger tab.
4. Click [Debug] button to begin debugging the application.
5. Extracting RZ Debug.

& Progress Information o X
'ﬁ‘ Preparing launch delegate.

Configuring GDB

Figure 63 : e? studio Debugger Configurations window with Blinky project (2)

4.5.2.1 Debug multi-core steps
To debug both the RZ/G3S CM33 core and the RZ/G3S CM33_FPU core simultaneously, follow these steps:

1. Create a separate e? studio workspace for each core. For example, use workspace_cm33 for the CM33
core and workspace_cm33_fpu for the CM33_FPU core.

workspace_cm33

workspace_cm33_fpu

Figure 64: Workspace creation

2. Launch e? studio and select the workspace for the CM33 core.

) & studio Launcher O X

Select a directory as workspace

e” studio uses the workspace directory to store its preferences and development
artifacts.

: | Chworkiw2h\workspace_cm33)| ~ |  Browse..

[ Use this as the default and do not ask again

» Recent Workspaces

Figure 65: Launch e? studio (for CM33 core)
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3.

Project Template Selection as shown in the figure below.

Create an FSP project for the CM33 core. In the configuration window, select the appropriate Core and

@ Renesss RZ/G C/C+ + FSP Project o X D Renesss RZ/G C/C+ + FSP Project [u]
Renesas RZ/G C/C- + FSP Project — | Renesas RZ/G C/C- + FSP Project —
Device and Tools Selection| | Project Template Selection
Device Selection Project Template Selection
FSP Version: it e otion ® | Bare Metal - Blinky
Board: RZ/G3S Evaluation Kit (SMARC Ba cwr::':iﬂ P hudes BSP and will blink LED: if available. This project will initialize clocks, pans, stacks, and
Device: RSACEGO45523GEG .
Core: Core 1(CM33) v o) = - Mini
I - I e (: Bare Metal - Minimal
Language  @C OC++ Bare metal FSP project that inchudes BSR This project will initislize clocks, ping, stacks, and the C runtime ment.
Truse No
Pins 159
Processor Cortex
IDE Project Type Debugger
& studio managed build v| KLk ARM
Tookhains
GNU ARM Embedded
Code Generation Settings
132 Manags Fock hais
DAL Makow aclchaltite: [ Use Renesas Code Formatter
i
2 o= = 2 = e

Figure 66

: CM33 Core Project Creation

4. Build the FSP project for the CM33 core.
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5.

Create an FSP project for the CM33 core. In the configuration window, select the appropriate Core and

Project Template Selection as shown in the figure below.

Renesas RZ/G C/C-++ FSP Project

Project Template Selection

Project Template Selection

® *| Bare Metal - Blinky
@' Bare metal FSP project that includes BSP and wil biink LEDs if available, This project will initalize clocks, pins, stacks, and
the C runtime environment.
[Renesas RZG.2.0.0pack]
] *| Bare Metal - Minimal

[Renesas.RZG.3.0.0.pack]

Code Generation Settings
Use Renesas Code Formatter

< Back

Bare metal FSP project that includes BSR This project will initialize clocks, pins, stacks, and the C runtime environment.

Cancel

@D Renesas RZ/G C/C++ FSP Project o X B3 Renesas RZ/G C/C++ FSP Project a x
Renesas RZ/G C/C++ FSP Project — Renesas RZ/G C/C++ FSP Project —
Device and Tools Selection Preceding Project or Smart Bundle Selection
Device Selection N
Board Description @® Preceding Project: | Blinky_cm3: iv
FSP Version: [3.0.0 -
reion Choose this option if you have access to the project source code of the preceding processor ¢ ore or security context.
Board: RZ/G3S Evaluation Kit (SMARC) <J[= C) Smart Bundle:
Device: ROADBG45533GBG
| core: Core 2(CM33_FPU) I | B o
e Device Details
L . @C OCs+
Fnauags = TrustZone No
Pins 358 Preceding Project/Smart Bundle Details
Processor Cortex-M33 FSP version 300
Toolchain GNU ARM Embedded
Toolchain version 133.1.am-13-24
Board RZ/G3S Evaluation Kit (SMARC)
Device ROACBGO45533GBG
IDE Project Type Debugger Core 33
& studio managed build v|  [kLinkarm ~ Zones 328
Tookchains
GNU ARM Embedded
1330.am-13-24 - fanage Toolchains.
8 Renesss RZ/G C/C+ + FSP Project a b

Figure 67: CM33 Core Project Creation

Build the FSP project for the CM33_FPU core.

Copy the two projects created in the CM33 core workspace into the CM33_FPU core workspace.

workspace_cm33 .metadata

copy

Blinky_cm33

workspac eucm33ufpl_i"<

Blinky_cm33_fpu

Figure 68: Project Copy
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8. Click the Debug Configuration in the workspace for the CM33 core, then click Debug.

€ Debug Configurations

Run | Window Help
Renesas Device Partition Manager || 2

@ Tracex
@ Tracealyzer
9. Run
% Debug 21
Run History )
O RunAs > b,
Run Configurations. A
Debug History |
#_Debug As ;
Debug Configurations |
3 |
|

Q. External Tools

Fiter matched 10 of 12 tems

@

Create, manage, and run configurations

e Debugging
r Debugging (RHES0)

Debug/Blinky_cm3elf

er| B Startup | (7] Common|

Source.

Variables...

=
|
e

Figure 69: CM33 core Debug Configuration

9. Launch e? studio anew and select the workspace for the CM33_FPU core.

& ¢ studio Launcher

Select a directory as workspace

m} x

e* studio uses the workspace directory to store its preferences and development artifacts.

[] Use this as the default and do not ask again

» Recent Workspaces

¥workspace_cm33_fpu

"J Eﬂrowse...l

Launch Cancel

Figure 70: Launch e? studio (for CM33_FPU core)
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10. Import the project for the CM33_FPU core.

& mport

Import Projects

Select a directory to search for existing Eclipse projects.

[u] x

[/~

@ Select root directory: ¥workspace_cm33_fpu¥Blinky.cm33 v || Browse..
(O Select archive file:
Projects:
Blinky_cm33. fpu (1 ¥workspace_cm33_fpu¥Blinky_cm33_fpul| | Select All
Deselect Al
Rgfresh
< >
Options.
[ Search for nested projects
[ Copy projects into werkspace.
[ Close newly imported projects upon completion
[JHide projects that already exist in the workspace
Working sets
[JAdd project to working sets Ne
elex
@ <Back Be Gance

Figure 71: Import CM33_FPU Core Project

11. In the CM33_FPU core workspace, click Debug Configuration and then click Debug.

Run | Window Help
Renesas Device Partition Manager

@ Tracex

@ Tracealyzer

@ Run

%, Debug
Run History

O Runhs
Run Configurations..
Debug History

% Debug As

Debug Configurations

Q. External Tools

8 Debug Configurations.

Create, manage, and run configurations

[€] Co+ Application
[E] CCo+ Remote Application
EASE Script
[£] GDB Hardware Debugging
[ GDE Simulator Debugging (RHESD)
CuleF1

11
|

|

& Launch Group

v [E9 Renesas GDB Hardware Debugging
1 Blinky_m33_fpu Debug_Flat

] Blinky_cm33 Debug_Flat
[E7 Renesas Simulstor Debugging (RX, R

< >

Filter matched 10 of 12 items

@

Name: [ Blinky_cm33_fpu Debug_Flat

[ Main| % Debugger | B Startup | % Source| [T} Common

Broject:
[Blinky_cma3 fpu Browse...
C/C+-+ Application:
| Debug/Blinky_cm33_fpu.elf
\ariables... | Search Project.. | Browse.

Build (if required) before launching
Build Configuration: | Use Active

O Enable auto build
@® Use workspace settings

O Disable auto build

Vorkspace Seiti

Close

Figure 72: CM33_FPU core Debug Configuration

12. This will enable the debugger functions for each core in their respective e? studio workspaces for the
CM33 core and the CM33_FPU core.
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4.5.3 Details about the Debug Process
In debug mode, e? studio executes the following tasks:

1. Downloading the application image to the microprocessor and programming the image to the internal

and/or external memory.

Setting a breakpoint at main().

Setting the stack pointer register to the stack.

Loading the program counter register with the address of the reset vector.
Displaying the startup code where the program counter points to.

ok wnN

Program Counter

355 [Blinky] RA Configfation  [d halentye | [ startupc 52
® = MC

L e out of re
void

U starts executing he
Reset_Handler (void)

e system using BSP. */

Figure 73 : e? studio Debugger memory window

4.5.4 Run the Blinky Project
While in Debug mode, click Run > Resume or click on the Play icon twice.

Figure 74 : e? studio Debugger Play icon

The LED on the Pmod LED should now be blinking.
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5. FSP application launch with e? studio

5.1 Creating a Project

5.1.1 What is a Project?
In €2 studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after
you launch e? studio and select a workspace, all projects previously saved in the selected workspace are
loaded and displayed in the Project Explorer window. Each project has an associated configuration file
named configuration.xml, which is located in the project's root directory.

I Project Explorer 33

w25 Blinky
g(f‘ Binaries
[ Includes
5 rzg
[ rzg_gen
2 src
= Debug
(= rzg_cfg
= script
[E] after build.bat
= Blinky Debug.launch
{5 configuration.xml
=| ROAOTGO44L23GBG.pincfg

Figure 75 : e? studio Project Configuration file

Double-click on the configuration.xml file to open the RZ MPU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner
of the e? studio window. Once selected, you can use the editor to view or modify the configuration settings
associated with this project.

5 | B c/C++ | FSP Configuration

Figure 76 : e? studio FSP Configuration Perspective

Note: Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ
Project Report file (rzg_cfg.txt) with all the project settings is generated. The format allows differences
to be easily viewed using a text comparison tool. The generated file is located in the project root
directory.
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£y Project Explorer 83

[&] after_build.bat

[ Blinky Debug.launch

46} configuration.xml

= ROA07GO44L23GBG.pincfg

= 0O |[E rzgefgtxt 2

FSP Configuration

Board "RZ/G2L Evaluation Kit (SMARC)"

< 2
Ve Bp"“ky ) 3 ROAG7G@44L23GBG
i, Binaries 4 part_number: ROAB7GB44L23GBG
[ Includes 5 rom_size_bytes: @
B rg 6 ram_size_bytes: 131072
2 rzg_gen : pa::age_s?yle: L;BGA
@ s s package_pins: 45
(= Debug 10 RZG2L
(= rzg_cig 1 series: 2
(= script 12

RZG2L Family

RZ/G2L Common
secure stack size (bytes): exzee
Main stack size (bytes): 0x20@
Heap size (bytes): @

18 MCU Vec (mV): 3308

19 Parameter checking: Disabled
Assert Failures: Return FSP_ERR_ASSERTION

Figure 77 : RZ Project Report

The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed
in the following sections.

Note: The tabs available in the RZ Project Editor depend on the e? studio version and the layout may vary
slightly, however the functionality should be easy to follow.

8% [Blinky] FSP Configuration X =0
Summary Generate Project Content

Project Summary A

RENESAS

Board: RZ/G3E Evaluation Board Kit (SMARC)

Device: RIADIGO4TESTGBG

Toolchain: GCC for Renesas RZ

Toolchain Version: 13.3.1.arm-13-24

FSP Version:

Project Type: Flat

Location:

Selected software components

Simple application that blinks an LED. No RTOS included

Board Support Package Common Files

/0 Port

General Timer

Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Interface

Arm CMSIS Version 6 - Core (M)

Board support package for ROA09GO47ESTGBG

Board support package for RZG3E

Board support package for RZ/G3E - FSP Data

RZ/G3E SMARC Evaluation Board Kit Support Files (RZ/G3E) v

QHO

Summary | BSP| Clocks | Pins| Interrupts | Event Links | Stacks Cu"'u.‘n:‘.’l'.sl

Figure 538 : RZ Project Editor tabs
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5.1.2 Creating a New Project
For RZ MPU applications, generate a new project using the following steps:
1. Click on File > New > C/C++ Project.

& work - & studio

File Edit Source Refactor MNavigate Search Project RenesasViews Run  Window Help

New

Alt+Shift+N > Renesas C/C++ Project - &
Open File... @ Makefile Project with Existing Code
3 Open Projects from File System... [€] C/C++ Project I} 7
Recent Files > 9 Project..

Figure 79 : New RZ MPU Project

2. Then click on the Renesas RZ/G C/C++ FSP Project template for the type of project you are creating.

e New C/C++ Project

Templates for New C/C++ Project

All GNU for R RZ C/C++ E ble Project
CMake FEZ A C/C++ Executable Project for Renesas RZ using
Make

the GNU ARM Embedded toolchain.

w GNU for Renesas RZ C/C++ Library Project

FE==~ A C/C++ Library Project for Renesas RZ using
the GNU ARM Embedded toolchain.

Renesas RZ/G C/C++ FSP Project
FE==~ Create an executable or static library C/C++
F5P project for Renesas RZ/G.

Renesas RZ/T C/C++ FSP Project
FEZ Create an executable or static library C/C++
FSP project for Renesas RZ/T.

Renesas RZ/V C/C++ FSP Project
FEZ=8~ Create an executoble or static library C/C++
FSP project for Renesas RZ/V.

< Back Next > Finish Cancel

Figure 80 : New Project Templates

3. Select a project name and location.

8 Renesas RZ/G C/C++ FSP Project

Renesas RZ/G C/C++ FSP Project —
Project Name and Location

<Back. Next > Finish Cancel

Figure 81 : RZ MPU Project Generator (Screen 1)
4. Click [Next >] button.
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5.1.2.1 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.

2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or select
Custom User Board for any of the RZ MPU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection. Only change
the Device when using the Custom User Board for the board selection.

4. Select the Core. You can select Core 1(CM33) or Core 2(CM33_FPU) if you selected RZ/G3S for the

Device.

To add threads, select RTOS, or No RTOS if an RTOS is not being used.

The Toolchain selection defaults to GNU Arm Embedded.

Select the Toolchain version. This should default to the installed toolchain version.

Select the Debugger. The J-Link Arm Debugger is preselected.

Click [Next >] button.

©e NG

B Renesas RZ/G C/C + FSP Project o x

Renesas RZ/G C/C++ FSP Project
| Device and Tools Selection

Device

FSP Version:
| Boara =
| Device: RIADIGO45522GEG

| core Core HCMI3) - ‘

language: @ C OCw+

L 350
Processor Contex-M33

1DE Preject Type Detugger
& studic managed build v [Fuinkarm

| Tooichsins

GNU ARM Embedded

1331 arm-13-24

<ok ; G

Figure 82 : RZ MPU Project Generator (Screen 2-1)

If Core 2(CM33_FPU) is selected in procedure 4, you need to select the preceding project.
To select the preceding project when creating the Core 2(CM33_FPU) project, it is required to prepare Core
1(CM33) before Core 2(CM33_FPU) project creation.

enesas RZ/G C/C++ FSP Project
8 Renesas RZ/G C/C++ FSP P o x

Renesas RZ/G C/C++ FSP Project

Preceding Project or Smart Bundle Selection

® Preceding Project Biinky

Choose this option if you have access to the project source code of the preceding processor core of security context.
| O 'smart Bundle:

300
GNU ARM Embedded
133.1.2m-13-24

RZ/G3S Evaluation Kit (SMARC)

RIADBGO45533GBG
33
Zones oM33s

@ <ok Gancel

Figure 83 : RZ MPU Project Generator (Screen 2-2)
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5.1.2.2 Selecting a Project Template

In the next window, select the build artifact, Sub-core start state and RTOS. Be sure that you select Secure

as Sub-core start state in the current version.

8 Renesas RZ/G C/C++ FSP Project m| X
Renesas RZ/G C/C++ FSP Project —
Build Artifact, RTOS Selection and Sub-Core Selection
Build Artifact Selection RTOS Selection
(® Executable Mo RTOS ~
* Project builds to an executable file
() Static Library
= Project builds to a static library file
Sub-core start state
(® Secure
* Start sub-core in secure state
() Non-secure
* Start sub-core in non-secure state
3 -
@ < Back Finish Cancel

Figure 84 : RZ MPU Project Generator (Screen 3)

In the next window, select a project template from the list of available templates. By default, this screen
shows the templates that are included in your current RZ/G MPU Pack. Once you have selected the

appropriate template, click [Finish] button.

Note: If you want to develop your own application, select the basic template for your board, Bare Metal -

Minimal or FreeRTOS - Minimal.s

B Renesas RZ/G C/C++ FSP Project o *

Renasas RZ/G C/C++ FSP Project

Project Template Selection

Project Template Selection

® o) Bare Metal - Blinky
Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and
the C runtime environment.

o d Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will iitialize clocks, pins, stacks. and the C runtime environment.

Code Generation Settings

[ Use Renesas Code Fermatter

o

OR

| € Notemplate selected

x|

B Renesas RZ/G C/Co+ FSP Project o

Renesas RZ/G C/C++ FSP Project

Project Template Selection

FreeRTOS - Blinky - Dynamic Allocation

FreeRTOS FSP project that includes BSP and will blink LEDs if available, FreeRTOS is pre-configured for dynamic memory
allocation. This project will initialize the MPU using the BSP. FreeRTOS will alsa be initialized and a single thread 1o blink
the LEDs will be started,

FreeRTOS - Blinky - Static Allocation

FreeRTOS FSP project that includes BSP and will blink LEDs if available, FreeRTOS is pre-configured for static memary
allocation. This praject wil initialize the MPU using the BSP. FreeRTOS wil alsa be initialized and a single thread to blink
the LEDs will be started.

" FreeRTOS - Mini

Emply FreeRTOS FSP proj
initialize the MPU using

tatic Allocation

with no threads. FreeRTOS is pre-configured for static memory allocation. This project wil

Code Generatian Settings
[r] Use Renesas Code Farmatter

[ <Back 1| Mext» Ein Cancel

Figure 85 : RZ MPU Project Generator (Screen 4)
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When the project is created, e? studio displays a summary of the current project configuration in the RZ MPU
Project Editor.

{5 [Blinky] FSP Configuration X

Summary Generate Project Content
Project Summary A
RENESAS
Board: RZ/G3E Evaluation Board Kit (SMARC)
Device: ROAOOGO4TESTGBG
Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version:
Project Type: Flat
Location:

Selected software components

Simple application that blinks an LED. No RTOS included

Board Support Package Common Files

O Port

General Timer

Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Interface
Arm CMSIS Version 6 - Core (M)

Board support package for ROA09G047ESTGBG

Board support package for RZG3E

Board support package for RZ/G3E - FSP Data

RZ/G3E SMARC Evaluation Board Kit Support Files (RZ/G3E)

[e) ¢~
Support [ji =

Summary | BS Event Links | Stacks ,’n“':L‘\:'u'--I

Figure 86 : RZ MPU Project Editor and available editor tabs

On the bottom of the RZ MPU Project Editor view, you can find the tabs for configuring multiple aspects of
your project:

o With the Summary tab, you can see all the key characteristics of the project: board, device,
toolchain, and more.

o With the BSP tab, you can change board specific parameters from the initial project selection.

e With the Clocks tab, you can refer to the MPU clock settings for your project. In the case of CM33
cold boot, you can configure the MPU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each port pin.
o With the Interrupts tab, you can add new user events/interrupts.
e With the Event Links tab, you can configure events used by the Event Link Controller.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in this tab,
the Properties window provides access to the configuration parameters, interrupt selections.

e The Components tab provides an overview of the selected modules. Although you can also add
drivers for specific FSP releases and application sample code here, this tab is normally only used for
reference.

The functions and use of each of the supported tabs are explained in detail in the next section.
Note: RZ/G2L, RZ/G2LC, RZ/G2UL and RZ/G3S don’t support Event Links tab.
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5.1.3 Duplication of Resources
In the case of RZ/G3S Core 2(CM33_FPU) project, duplicate resources are indicated as red character in
Stacks tab when using resources that are used in the linked Core 1(CM33) project.

The following image is the example that both of Core 1(CM33) and Core 2(CM33_FPU) projects are created
with Blinky template. The duplication of r_gtm is indicated in Stacks tab. To avoid this duplication, please
change the channel resource in Properties of r_gtm.

{&} [Blinky_Core1) FSP Configuration

Stacks Configuration

[Blinky_Core2] FSP Configuration X<

o
Generate Project Content

€] NewStack > =& Extend Stack > &

Threads = HAL/Common Stacks
~ g HAL/Common o /0 Po n}.. (r : 0 QSPI
— oy 4 g ioport O Port Gtme e eI | ¥ o_aspi0 Gs
# g_ioport O Port (r_ioport (r_iopart) (xspi_gspi)
& o_timer2 Timer {r_gtm!
# 9_qspi0 QSPI (r_xspi_gspi

t Linksd @ Stacks| Components

Summary | BSP | Clocks | Pins | Interrupts

[£2 Problems | [T Properties X | @ Smart Browser & Console

g_timer2 Timer (r_gtm)

A stack
This instance may be referenced by

ent with a bar of this col

jor indicates ‘g_timer2 Timer (r_gtm)’ is a Module instance.
"

Error: Peripheral ‘GTM2" is allocated within a preceding project or smart bundle

Settings  PrOPEY Value
v Common
Parameter Checking Default (BSP)
~ Module g_timer2 Timer (r_gtm)
v General
Nam g limer2
| channet GTMZ |
Mode Periodic
Period 8
Period Unit Hertz
Count Source POCLK

Interrupts
Extra Features

Figure 87 : Duplication of resource between Core 1(CM33) and Core 2(CM33_FPU) projects
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5.2 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user
code is executed is set by the configuration settings in the BSP tab. When you select a project template
during project creation, e? studio configures default values that are appropriate for the associated board. You
can change those default values as needed. The following sections detail the process of configuring each of
the project elements for each of the associated tabs.

5.2.1 Summary Tab

8} [Blinky] FSP Configuration

Summar:
¥ Generate Project Content

Project Summary A
eENESAS

Board: RZ/G3E Evaluation Board Kit (SMARC)

Device: ROADOGO4TESTGBG

Toolchain: GCC for Renesas RZ

Toolchain Version: 13.3.1.am-13-24

FSP Version:

Project Type: Flat

Location:

Selected software components

Simpla application that blinks an LED. No RTOS included
Board Support Package Common Files

10 Port

General Timer

Quad Serial Peripheral Interface Flash on Expanded Serial Peripheral Interface

Am CMSIS Version 6 - Core (M)

Board support package for ROAVIGO47ESTGEG

Board support package for RZG3E

Board support package for RZ/G3E - FSP Data

RZ/G3E SMARC Evaluation Board Kit Support Files (RZ/G3E) v

Q=0

Summary JBs

Figure 88 : Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It
shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the
selected software components and modules used by the project. This is a more convenient summary view
when compared to the Components tab.

5.2.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is in the lower left
of the Project Configurations view as shown below.

Note: If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.

SJ“V‘]VE‘E ocks | Pins | Interrupts | Event Links | Stacks | Components
Properties X Problems Smart Browser Console

RZ/G3E Evaluation Board Kit (SMARC)

Settings Property Value

v ROAD9G0O47ES7GBG
part_number RYA09G047ES7GBG
rom_size_bytes 0
ram_size_bytes 524288
package_style FCBGA
package_pins 529

v RZ/G Common
Secure stack size (bytes) 0x1000
Main stack size (bytes) 0x1000
Heap size (bytes) 0x4000
MPU Vcc (mV) 3300
Parameter checking Disabled

Assert Failures
Error Log

Return FSP_ERR_ASSERTION
No Error Log

PFS Protect Enabled

C Runtime Initialization Enabled

Early BSP Initialization Disabled
v RZG3E Family

Enable inline BSP IRQ functions Enabled

Figure 89 : Configuration BSP tab
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The Properties view shows the configurable options available for the BSP. These can be changed as
required. The BSP is the FSP layer above the MPU hardware. e? studio checks the entry fields to flag invalid
entries. For example, only valid numeric values can be entered for the stack size.

When you click [Generate Project Content] button, the BSP configuration contents are written to
rzg_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist.

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.

5.2.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for
dedicated numerical calculation. For example, scif_uart driver calculates the communication rate from the
settings in Clocks tab. Please note that the clock configuration is carried out on the main core (CA55) in
advance when CM33 work as sub core. Thus, clocks configuration here must align with the settings on
CA55.

In the case of CM33 cold boot, BSP will configure each clock setting in start-up process according to content
of Clocks tab. If a clock setting is invalid, the offending clock value is highlighted in red. It is still possible to
generate code with this setting, but correct operation cannot be guaranteed. In the figure below, the xSPI
clock SPIOCLK has been changed so the resulting clock frequency is 400 MHz instead of the required less
than 267 MHz. This parameter is colored red.

i9¢ *[Blinky] FSP Configuration X = 8

Clocks Configuration

Generate Project Content

EZ Restore Defaults

L Div /2 400MHz > OCCLK Sel: 266MHz ~ ~ —>{ OCCLK Div /8 v —>{ OCOCLK ~33.333MHz PS
Div /6 ~266.667MHz - Div /2 ~ IE.E&?MHZ — OCICLK ~16.667MHz

p- SPICLK Sel: 400MHz ~ ~ — SPICLK Div /1 ~ —>1 SPIOCLK 400MHz
[ Div /1000 Div /2 ZDOMiz — SPI1CLK 200MHz
> PLL4 800MHz l Sel: OSC Div /1000 v —= Div /2 12kHz SOCLK 12kHz
[> PLL6 S00MHz —> Div /2 250MHz 12CLK Div /1 v —>! 12CLK 250MHz

‘ L I3CLK Div /1 ~ —> 13CLK 250MHz

HPCLK 250MHz

~> Div /3 0SC2 8MHz

Summary BSPPins Interrupts | Event Links | Stacks | Components

Figure 540 : Configuration Clocks tab

When you click [Generate Project Content] button, the clock configuration contents are written to
rzg_gen/bsp_clock_cfg.h. This file will be created if it does not already exist.

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
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5.2.4 Configuring Pins

The Pins tab provides flexible configuration of the MPU’s pins. As many pins can provide multiple functions,
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral
offers multiple options for the location of the receive and transmit pins for that module and channel. The
location and function of the pins are shown in the FSP Visualization view. For more information on the
function and color coding of the pins, please check the Legend in the FSP Visualization view.

% [Blinky] FSP Configuration = B | “F FsP Visualization X =
g . q o >
/ p Pin Func.. ~ »>
Pin Cunflguratlon Generate Project Content :‘ ol P !
Select Pin Configuration |2 Load DTS configuration A Export to CSV file 3 Configure Pin Driver Warnings voes b0l
‘ RZG35-SMARC. pincfg v Manage configurations.. & .:
Generate data: |g_bsp_pin_cfg -
PinSelection = [ = |4, Pin Configuration =3 Cycle Pin Group e el
- -
ipheralac ~ Pin Group Selection Mixed &
per!pheral‘R"C Operation Mode Disabled
y per!pheralszpl ~ Input/Output
’ Pe'fph”'al‘sm SCIF4_RXD None
v "er;';;;a SCIF4 SCK None
i SCIF4_TXD None o .
SCIF1
SCIF2 e
SCIF3 -
SCIF4 . s 4 € a s
SCIFS Ll 2 2 =1 =) 80 -
peripheral:5Clg v Module name:  SCIF4 . - 3 2 -
< > Usage: Serial Communication Interface with FIFO T 1=1 -1 - - -

Pin Function | Pin Number

Summary | BSP Clctkslmerrupis Event Links | Stacks | Components » Legend

Figure 91 : Pin Configuration

The pin configurator includes built-in conflict checker. So, if the same pin is allocated to another peripheral or
I/O function, the pin will be shown as red in the FSP Visualization view and with white cross in a red square
in the Pin Selection pane and Pin Configuration pane in the main Pins tab.

In the example shown below, port P13_1 is already used by the GPT, and the attempt to connect to this pin
to the Serial Communication Interface with FIFO (SCIF) results in dangling connection error. To fix this error,
select another port from the pin drop-down list or disable the GPT.

1 *[Blinky] FSP Configuration X =

Pin Configuration Generate Project Content

Select Pin Configuration ) Load DTSi configuration ] Export to CSV file [£ Configure Pin Driver Warnings
[ RzG35-SMARC pincfd| v Manage configurations
Generate data
PinSelection i~ [+ = [% Pin Configuration 22 Cydle Pin Group
m Name Value Lock  Link
Pin Group Selection Mixed
peripherali3C A Operation Mode Custom
¥ peripheralRIIC « Input/Output
¥ peripheral:RSPI SCIF1_CTS_N None
v @ peripheral:SCIF SCIF1_RTS N None
scrro SCIF1_RXD @‘ P131 @
LEER) SCIF1_SCK None
sar2 SCIFI_TXD None
SCIF3
SCIF4
< >
SCIFS
peripheralsClg ', | | Module name: ~ SCIF1
> Usage: Serial Communication Interface with FIFO

Pin Function | Pin Number,

Summary | BSP | Clocks _ Pins | Interrupts | Event Links | Stacks| Components

Figure 92 : e? studio Pin Configurator

When you click [Generate Project Content] button, the pin configuration contents are written to:
rzg_gen\pin_data.c. This file will be created if it does not already exist.
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Warning: Do not edit this file as it is overwritten whenever the [Generate Project Content] button is clicked.

In the case of versions earlier than RZ/G FSP v2.0.0, It does not support Pins tab and If user would like to
use I/O port, 1/0 Port setting should be applied to “src/pin_data.c” manually. For details on I/O Port setting
and how to apply the setting of “src/pin_data.c” to Pins tab, please refer to Setting GPIO with Flexible
Software Package.

5.2.5 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority.
Select the driver in the Stacks pane to view and edit its properties.

£ Binky] P Configurston 5

Stacks Configuration

Threads =/ HAL/Common Stacks &) New Stack > 4] Remove

ioport 1/0 Port Driver on r_ioport @ g ioport /O Port 4 g_timer0 Timer Driver
& aon o Driver on r_ioport onr.gtm

Summary [BSP | Clocks |Pins | Interrupts  Event Links | Stacks | Components|

I vovers 37700 mi=o

g_timer0 Timer Driver on r_gtm

Settings  Property Value

Default (85P)

NULL

ty s
Disable

@ von - o X
File Edit ject Run  Window el
R[4 |[ m] | % oewo 7 Blinky Debug > b S A AT A dte AR 1R R S 41
8 | o [P e & - B - - Q
o
5
Oriver > Connectii
FreeRTOS
Middbevar I
Search..
i
Objects
Summary | BSP | Clocks Pins | Intermupts | Event Links | Stacks | Components.

Figure94: Add new stack Timer (GTM)

5.2.6 Creating Interrupts from the Interrupts Tab
On the Interrupts tab, the interrupts of the driver which user selected in the Stacks tab are registered.

User Events & New UserEvent >

AAAAAA

Summry [BSP Clocks PinsInternupts  Event Links| Stacks] Components

Figure 95 : Configuring interrupt in Interrupt Tab
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Also, on the Interrupts tab, the user can add user’s own peripheral interrupts. This can be achieved by
adding a new event via the [New User Event] button.

5.2.7 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.

{2} *[MyProject] FSP Configuration X =

Event Links Configuration Generate Project Content

User Events Produced &) New User Event > User Events Consumed &) New User Event

E

vent Peripheral Function Event
I GPT_U0_GPT_GTCIL_N_0 (GPTO A and B both low interrupt) I é I Single port 0 GPT_U0_GPT_GTCIL_N_0 (GPTO A and B both low interr.. I

Allocations
Peripheral Function Event

Input port group 2 (Port 8) No allocation
L . Mo allocaii

I Single port 0 GPT_U0_GPT_GTCIL_N_0 (GPT0 A and B both low interrupt) I
ngTE port T TG allocstion
Sinale port 2

aaaaaaaaaaaa

Summary |BSP | Clocks |Pins [ Interrupts | Event Links| Stacks| Components

Figure 96 : e2 studio Project configurator — Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can be
defined by clicking the relevant [New User Event] button. Once a consumer is linked to a producer the link
will appear in the Allocations section at the bottom.

Note1: When selecting an ELC event to receive for a module (or when manually defining an event link), only
the events that are made available by the modules configured in the project will be shown.
Note2: On devices that do not have ELC, this tab is not available.

5.2.8 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application
using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common
Stacks.

2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.

3. Select a driver from the menu New Stack > Driver.

Stacks Configuration

Threads ] |HALCommon Stacks I

¥ g_ioport /0 Port Driver on r_ioport ¥ g,mpmwo vm:‘

Generate Project Content i Includes

Figure 97 : e? studio Project configurator - Adding drivers

4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the
Properties view.

e? studio adds the following files when you click [Generate Project Content] button:
e The selected driver module and its files to the rzg/fsp directory

e The main() function and configuration structures and header files for your application as shown in the
table below.
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only code. Add your code here.

File Contents Overwritten by Generate
Project Content?
rzg_gen/main.c Contains main() calling generated | Yes
and user code. When called, the
BSP has already initialized the
MPU.
rzg_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.
rzg_gen/hal_data.h Header file for HAL driver only Yes
modules.
src/hal_entry.c User entry point for HAL Driver No

The configuration header files for all included modules are created or overwritten in this folder:

rzg_cfg/fsp_cfg
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5.3 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded.
Modules common to all RZ/G MPU projects are preselected. All modules that are necessary for the modules
selected in the Stacks tab are included automatically. You can include or exclude additional modules by

ticking the box next to the required component.

483 [Blinky] FSP Configuration §3

Components Configuration

Component Version
v %y BSP
v @ Board
] custom
V] rzg2l_smarc
v @ rzg2l
V] device

device

ORE

device
] device
device
| device
| device
¥ fsp
v ¢y CMSIS
v @ CMSISs
[¥] CoreM
DsP
[[] NN
v ¢y Common
v @ all
[¥] fsp_common
w % HAL Drivers
v @ rzg2l
[ rgpt
¥ r_gtm
[¥] r_ioport

e i LA i "
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components

= 8

Generate Project Content

v | | Search...

Variant (o)

Filter |All

Description

Custom Board Support Files
Evaluation Kit RZ/G2L Support Files (R...

Board support package for ROAQ7G044... RIAQ7GO4...
Board support package for RZG2L (RZG)
Board support package for ROAO7GO4M...
Board support package for ROAO7G04...
Board support package for ROA07G044..,
Board support package for ROA07G044..,
Board support package for ROA07G044...
Board support package for RZ/G2L (RZ...

ROAQ7GO4...
RIAO7GOM...
RIAO7GOM...
RIAO7GOM...
RIAQTGOM...

Arm CMSIS Version 5 - Core (M)
Arm DSP Library Source
Arm NN Library Source

Board Support Package Common Files

General PWM Timer
General Timer

1/O Port

TPV

Figure 98 : Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected component into

the following folders:
e rzg/fsp/inc/api
o rzg/fsplinc/instances
e rzg/fsp/src/bsp

e rzg/fsp/src/<Driver_Name>

e? studio also creates configuration files in the rzg_cfg/fsp_cfg folder with configuration options set in the

Stacks tab.
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5.4 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to the board

and execute it.

To debug an application, follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

i3 =0

T1 1F58 project Debug
Debug &3 '
Debug Configurations...
Organize Favarites.,

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

B vevug Configurations

Create, manage, and run configurations

®

45 Debugger po Startup| [ Commen E» Source

Erowe

RN Bame: | WiyProject Debug
[} Mein

£] A ) Eroject:

[T /C++ Remate Applicatic

4 EASE Script \W’w:cr

[ GDB Hardware Debuggin:
[ GDB OpenCCD Debuggin

C/Ce+ Application:
[ DebughyPrsjectan

5 GDB Simulator Debugginy
Java Applet
Java on

Build (i required) before leunching

on: Use Active

Flarnete lava Appl ieabizn
~ [E¥ Aenesas GOB Hordware D

[E] My raj 'q
[ Renesas Simulator Debug

< >
Fifter matched 14 of 16 items

@

Wariables..

Search Project..| | Browse..

3. Secure and Non-secure Vector Address are configured in the Connection Settings tab of the Debugger
tab. The settings in below image are for setting the address of Secure and Non-secure Vector Offset
mapped in Blinky project. Please note that these addresses vary in accordance with linker settings.

& Debug Configurations

Create, manage, and run configurations

Name: [Blinky Debug_Flat

[5) Main (3% Debugger. B Startup | &

Debug hardware: | I-Link ARM

Saurce [] Comman

Application
note Applicalion Target Device: ROADTGO44L23GBG_
EASE Script

[ GO Hardware Debugaing | |  GDB Settings Conneclion Setlings | Debug Tool Settings

7 GOE Simulator Debugging Reset at the beginning of connection Vs v oA
3 Launch Group Resel at the end af connection Na -
v [ Renesas GDB Hardware De Reset before download Na v
[E7] Biinky Debug_Fiat Reset after download Ho >
¥ Renesas Simulator Cebugg ID Code (Bytes) FRFFFFFFFFFFFEFFEFFFFFFFFFFEFFFF
Hold reset during connect Na v
Set CPSR(Sbil] ater download Na v
Prevent Rel the Reset of the CM3 Core_ Ves v
Secure Veclor Address B _secuc vectors 1
[Fen-secure Vector Address &_Vectors a—
Fiot Flug
Discannection Made stop
~ sy
Core clock (MHz) 0
v TrustZone
Set TrustZone sacure/non-secure boundaries v
< >
Filter marched 9 of 11 irems e L
2 e

4. Connect the board to your PC via a standalone Segger J-Link debugger and click [Debug] button.

Note: For details on using J-Link and connecting the board to the PC, see 3.1.2.2.JTAG connection.
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5.5 Modifying Toolchain Settings

There are instances where it may be necessary to make changes to the toolchain being used (for example,
to change optimization level of the compiler or add a library to the linker). Such modifications can be made
within e? studio through the menu Project > Properties > Settings when the project is selected. The
following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly
different depending upon the toolchain being used.

B Properties for Blinky

<

Resource
Builders
C/C+= Build
Build Varizbles
Environment
Logging
Settings
Toal Chain Editor
CfC++ General
MY
Project References
Renesas OF
Fun/[Iebug Settings
Task Repositery
Task Tags
Walidation

Settings

Configuratior: | ebug [ Active]

 ToolSetings  BR Toolchain JF

|22 Target Processor

(2 Optimization

(2 Wamings

(E Debugging
w B GMU ARM Cross Assernbler
# Preprocessor
% Includes

armings
¢ Miscellanecus
¥ GNU ARM Cross C Compiler
5 Preproessar
12 Includes
(B Optimization
12 Wamnings
(2 Miscellaneous
~ B GMNU ARM Cross C Linker
(B Genenal
B Libraries

8 Miscellaneous

88 GNU ARM Cross Create Flash Image

s
(% Genersl
M R ADR L e i i

*~ | Manage Configurations..,

Build Steps Build Artifact |np Binary Parsers €3 Emor Parsers
LRM farnily cortex-md -
Architerture Toolchain default b

Instruction et Thumb (-mthumb)
LI Thumb interaark (-rrthumb- interae i)
Endianness Toolchain default Al
Float AEI FF instructions (hard)
FRU Type Fpud-sp-d 16 s
Unaligned access | Toelchain default w
Generic [-mogu= genen<
Toalchain default
Toolchain default
Toolchain defaulk

Enabled i+ simd

Small [-memaodel=small)

Apply and Close

Cangel

Figure 99 :

e? studio Project toolchain settings

The scope for the settings is project scope which means that the settings are valid only for the project being

modified.

The settings for the linker which control the location of the various memory sections are contained in a script
file specific for the device being used. This script file is included in the project when it is created and is found
in the created project. (for example, script/fsp.ld).
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5.1 Importing an Existing Project into e? studio

1. Start by opening e? studio.
2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist,
proceed with the following steps:

a. Atthe end of e? studio startup, you will see the Workspace Launcher Dialog box as shown in the
following figure.

Eclipse Launcher X

Select a directory as workspace

€ studio uses the workspace directory to store its preferences and development artifacts.

ELEMC\Users\ < user_name\eZstudio\workspace

[] Use this as the defautt and do not ask again

} Recent Workspaces

Figure 100 : Workspace Launcher dialog

b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure.
e? studio creates a new workspace with this name.

[ Eclipse Launcher x

Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

EIlIC:\ Users\ <username: \e2studia\new_workspace]

[ Use this as the default and do not ask again

+ Recent Workspaces

Figure 102 : Workspace Launcher dialog - Select Workspace

c. Click [Launch] button.
d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench
arrow button to proceed past the Welcome Screen as seen in the following figure.

RENESAS Welcome to e2 studio )
Workbench

Figure 102 : Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu in the menu
bar, as shown in the following figure.

Q fspWorkspace - FSPproject/confii
File Edit Navigate Search Proje €= Menu bar

4 Debug <« Tool bar

- - v")
™

Figure 103 : Menu and tool bar
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4. Click Import on the File menu or “Import project” on Project Explorer, as shown in the following figure.

File Edit Mavigate Search Project RenesasViews Ru

Export...

New AltsShiftsN > § i Project Explorer i3 =
Open File... 5% 7 8
Open Projects from File System...

Recent Files > There are no projects in your workspace.

Convert Line Delimiters To >

Prin

Properties AlteEnter

Switch Workspace >
Restart

Exit

Refres

To add a project:

ar

Figure 104 : File drop-down menu

5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing
Projects into Workspace, to import the project into the current workspace.

& import [m] X
Select \“
Create new projects from an archive file or directory. E E

Select an import wizard:

[type filter text |

v (= General ~

I Archive File
4 cMsIS Pack
[ Existing Projects into Workspace
[} File System
@ GMNUARM-NONE/RZ(DS-5) project conversion to GCC ARM Embedded
[T Preferences
[} Projects from Folder or Archive
(2 Rename & Import Existing C/C++ Project into Workspace
& Reneas Web¥ 4 b EOH VT )L-FOVII R
Ta# Renesas CATEKOR (CS+) JOIT-
T Renesas CC-RX/CC-RL (CS+) 7O+
Ta# Renesas GitHub FreeRTOS (with |oT libraries) 03Tk

= UC++

(= Install hd

@ <Back Finish Cancel

Figure 55 : Project Import dialog with "Existing Projects into Workspace" option selected
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6. Click [Next >] button.
7. To import the project, use either Select archive file or Select root directory.

a. Click Select root directory file as shown in the following figure.

& import [m] ®
Import Projects S
Select 2 directory to search for existing Eclipse projects. / “
(®) Select root directory: |\ V][ Browse..
O Select archive file: Brows
Projects:
Select All
Deselect Al
Refresh
Options
[ Search for nested projects
[ Copy projects into workspace
[JClose newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
[] Add project to working sets New...
@ <Back Next Finish Cancel

Figure 56 : Import Existing Project dialog 1 - Select root directory

b. Click [Browse] button.
c. For Select root directory, browse to the project folder that you want to import.
d. Select the file for import.
e. Click [Open] button.
f. Select the project to import from the list of Projects, as shown in the following figure.
& Import ] X
Import Projects —
Select a directory to search for existing Eclipse projects. / /4
(@) Select root directory: | C:¥works RZG_V¥work ~ I Browse... |

() Select archive file:

Projects:
Blinky (C:¥works_RZG_V¥work¥Blinky) Select All
Deselect All
Refresh

Figure 57 : Import Existing Project dialog 2
8. Click [Finish] button to import the project.
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Revision History

Description
Rev. Date Page Summary
3.1.0 Jul.22.25 40, Added the description for the template of the RZ/G3E CM33
46 to 50, cold boot
Added the description how to debug the RZ/G3S CM33 and
CM33_FPU at the same time.
Added the description whether a project is bundled to another
project when creating new project.
3.0.0 Mar.31.25 4 to 20, Updated the description and figure based on the latest
31 to 35, development environment.
37 to 40,
46, 48,
50 to 52,
56
21.0 Sep.30.24 6 to 11, Updated the description and figure based on the latest
13 to 22, development environment.
35 to 36,
42,44,
46,48,
59 to 67
2.01 Feb.13.24 6 to 11, Updated the description and figure based on the latest
13 to 22, development environment.
45 Updated the description of project creation.
48 Added the section of how to avoid resource duplication
description in the case of RZ/G3S project creation.
60 to 69 Added the section of how migrate the project which using
previous FSP version to latest FSP version.
2.00 Jan.9.24 1 Added RZ/G3S to the target device.
5 Updated the description of the RAM initialization section.
6to 11 Updated the description and figure based on the latest
development environment.
12 to 22 Updated the development setup for Linux Host PC and FSP
installation.
26 to 32 Added description and figure for RZ/G3S SMARC EVK.
33 to 36 Updated the description and figure based on the latest
development environment.
40 Removed the steps to configure Secure Vector and Non-
secure Vector from the Debug step.
46 to 51 Added description about the Pins and Clocks tabs.
55 Updated the instructions for configuring Secure Vector and
Non-secure Vector.
1.20 Nov.30.22 12 Updated version information of SEGGER J-Link driver and
Libgen Update for GNU ARM Embedded Toolchains.
18, 24 Updated installation procedure for FSP packs.
67 Updated the method of specifying Secure Vector Address and
Non-secure Vector Address.
1.10 Apr.27.22 5to 53 Updated the description and figure based on the latest
development environment.
1.01 Dec.3.21 14 to 22 Added a section of e? studio installation for Linux PC.
1.00 Jul.30.21 - First Edition issued.

RO1AN5924EJ0310 Rev.3.10
July.22.25

Re Page 72 of 72
KENESAS




General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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